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HEADING 4 STYLE 

Use the small tables provided in some of the 
articles to call out quick reference information 
related to the article, such as contact 
information or event dates. 

HEADING 5 
Contact Info 

 
 

To setup a document for multiple column 
text, on the Page Layout tab, in the Page 
Setup group, click Columns and then click 
the number of columns you need. You can 
also click More Columns to specify column 
widths, the space between columns, or to 
automatically add a vertical line between 
columns. 

To change the number of columns for just 
part of the document (or if you want text to 

wrap to just the top part of the page and a 
new article to start below – as shown on this 
page), insert a section break before the 
position where you want to start the new 
column layout. To do this, on the Page 
Layout tab, in the Page Setup group, click 
Breaks and then click the type of section 
break you need.  

Using Styles 
by Name Style 

Working with Columns 
by [Article Author] 

This picture caption uses the Caption 2 
paragraph style and is inside a text box 
so that you can move it easily as 
needed to accompany a photo.  
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Select a section break 
When changing many types of page layout 
formatting for just part of the document—
such as paper size, margins, or orientation, 
the best section break type to use is a Next 
Page section break because it automatically 
starts the new section on a new page. 
However, when changing the number of 
columns as you might in this newsletter, you 
may prefer to select a Continuous break. The 
continuous section break (used a few times 
throughout this template) starts a new 
section immediately after the preceding one. 
So, for example, you can have a three-
column article followed by a four-column 
article, on the same page. 
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HEADING 4 

 

Sidebar Setup 
The sidebars in this template use simple, single-row 
tables for the gray-shaded headings and 
thermometer charts shown below for easy alignment. 

 

Add Sidebar Content 
Adding content into a column to create a sidebar is no 
different from adding text. As noted earlier in this 
template, apply the styles provided for headings, 
sidebar text, and even pictures to align them quickly and 
easily. 

FAST FACTS 
 

  

68% 
Learn about these “thermometer charts” in the article at 
right. 

  

42% 
Cras ut blandit diam. Suspendis quis urna semper 
aliquam. 

FOR MORE INFORMATION 

Abico eum, ille et, conventio obruo duis 
ullamcorper ut, neo demoveo. Vel reprobo: 

HEADING 5 
Contact Info 
 

 

 

This placeholder article provides the 
following tips: 

 Creating “thermometer charts” using 
tables, as shown at left. 

 Setting up multipage articles. 

 Wrapping text around images 

 Adding article titles and bylines 

Creating the sidebar 
thermometer charts 
When you work in Word 2010 (or PowerPoint 
2010), you have the full power of Excel 2010 
charts (provided that Excel is installed on 
your computer). Insert a chart in Word from 
the Insert tab, in the Illustrations group. 
Charts are easy to create and use and 
automatically coordinate with your active 
document theme. 

However, notice in the sidebar at left that the 
“thermometer charts” were created using 
single-row Word tables. This is because they 
automatically fit the tight space without 
having to remove any chart elements. And 
you might be surprised to learn that it’s easy 
to make them essentially mathematically 
accurate. 

To use a table as a thermometer chart, do 
the following: 

1. On the Insert tab, in the Tables group, 
click Table and then drag across the grid 
to select the first two cells in the first 
row. Click to insert a two-cell, one-row 
table. 

2. Click in the table and then, on the Table 
Tools Layout tab, in the Table group, 
click Properties.  

3. On the Columns tab of the Table 
Properties dialog box, change the 
Measure In setting to Percentage. You 
can then set the percentage to up to one 
decimal point in accuracy. 

Setting up multipage articles 
Word is designed to allow text to 
automatically flow from one page to the 
next. So, when you want an article to 
continue on the next page, just keep typing. 

In the case of this placeholder article, it is 
separated into two placeholder content 
controls (one on this page and another that 
starts at the top of the following page) just so 
that you can still see the layout of the 
following page while you begin adding your 
own text on this page. As 
mentioned on the first page of 
this template, remember that it 
might look like the layout is 
skewed when you 
replace a long piece of 
placeholder text by 
starting to type your 
own, but it is not. As you 
add your content, the 
layout that follows will 
move down 
automatically and 
back into position. 

To remove the second 
placeholder control that starts immediately 
following this one, just select it and then 
press any key. You can then continue typing 
from this page and your text will 
automatically flow onto the next. 

Formatting Tips 
by [Article Author] 

Caption 2 style is used to add 
picture captions. Captions are in 
text boxes for easy placement 
relative to images. 
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FOR MORE INFORMATION 

Abico eum, ille et, conventio obruo duis 
ullamcorper ut, neo demoveo. Vel reprobo: 

HEADING 5 
Contact Info 

 

  

Remove Image 
Backgrounds 
by [Article Author] 
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Lorem ipsum dolor sit amet, consectetur 
adipiscing elit. Nullam sed luctus tellus. 
Pellentesque in dolor sapien, vitae dictum 
massa. Donec nunc velit, pretium eu 
pellentesque eget, mollis vel arcu. 

Etiam et mauris ac augue porttitor pretium. 
Suspendisse vel purus nec erat pellentesque 
commodo. Aliquam tempus aliquam mauris 
vel dapibus. Nullam at metus erat, in 
convallis massa. Aliquam erat volutpat. 
Praesent ultrices odio in elit fringilla id 
rutrum mi mattis. 

Phasellus sagittis tempus massa, a tempor 
libero condimentum eu. Morbi ut nisi ante. 
Duis purus eros, aliquam eu cursus tincidunt, 
feugiat vitae magna. Etiam sodales 
consequat nibh, eget rhoncus metus 
convallis et. Morbi rutrum mollis facilisis. 
Aenean faucibus sapien erat, eu pharetra 
arcu. 

Phasellus sagittis tempus massa, a tempor 
libero condimentum eu. Morbi ut nisi ante. 
Duis purus eros, aliquam eu cursus tincidunt, 
feugiat vitae magna. Nullam pellentesque, 
est at consectetur interdum, arcu dolor 
interdum. Nullam at metus erat, in convallis 
massa. 

Lorem ipsum dolor sit amet, consectetur 
adipiscing elit. Nullam sed luctus tellus. 
Pellentesque in dolor sapien, vitae dictum 
massa. Donec nunc velit, pretium eu 
pellentesque eget, mollis vel arcu. 

Etiam et mauris ac augue porttitor pretium. 
Suspendisse vel purus nec erat pellentesque 
commodo. Aliquam tempus aliquam mauris 
vel dapibus. Nullam at metus erat, in 
convallis massa. Aliquam erat volutpat. 
Praesent ultrices odio in elit fringilla id 
rutrum mi mattis. 

Aenean vitae lorem dui. Morbi tempus lacinia 
nisi, vel scelerisque nibh facilisis id. Integer 
urna tortor, ullamcorper aliquet viverra non, 
mollis sed dolor. 

Phasellus sagittis tempus massa, a tempor 
libero condimentum eu. Morbi ut nisi ante. 
Duis purus eros, aliquam eu cursus tincidunt, 
feugiat vitae magna. Etiam sodales 
consequat nibh, eget rhoncus metus 
convallis et. Morbi rutrum mollis facilisis. 

Aenean faucibus sapien erat, eu pharetra 
arcu. 

Phasellus sagittis tempus massa, a tempor 
libero condimentum eu. Morbi ut nisi ante. 
Duis purus eros, aliquam eu cursus tincidunt, 
feugiat vitae magna. Nullam pellentesque, 
est at consectetur interdum, arcu dolor 
interdum. Nullam at metus erat, in convallis 
massa. 

Nullam at metus erat, in convallis massa. 
Aliquam erat volutpat. Praesent ultrices odio 
in elit fringilla id rutrum mi mattis. 

Lorem ipsum dolor sit amet, consectetur 
adipiscing elit. Nullam sed luctus tellus. 
Pellentesque in dolor sapien, vitae dictum 
massa. Donec nunc velit, pretium eu 
pellentesque eget, mollis vel arcu. 

Etiam et mauris ac augue porttitor pretium. 
Suspendisse vel purus nec erat pellentesque 
commodo. Aliquam tempus aliquam mauris 
vel dapibus. Nullam at metus erat, in 
convallis massa. Aliquam erat volutpat. 
Praesent ultrices odio in elit fringilla id 
rutrum mi mattis. 

Aenean vitae lorem dui. Morbi tempus lacinia 
nisi, vel scelerisque nibh facilisis id. Integer 
urna tortor, ullamcorper aliquet viverra non, 
mollis sed dolor. 

Phasellus sagittis tempus massa, a tempor 
libero condimentum eu. Morbi ut nisi ante. 
Duis purus eros, aliquam eu cursus tincidunt, 
feugiat vitae magna. Etiam sodales 
consequat nibh, eget rhoncus metus 
convallis et. Morbi rutrum mollis facilisis. 
Aenean faucibus sapien erat, eu pharetra 
arcu. 

Etiam et mauris ac augue porttitor pretium. 
Suspendisse vel purus nec erat pellentesque 
commodo. Aliquam tempus aliquam mauris 
vel dapibus. Nullam at metus erat, in 
convallis massa. Aliquam erat volutpat. 
Praesent ultrices odio in elit fringilla id 
rutrum mi mattis. 

Nullam at metus erat, in convallis massa. 
Aliquam erat volutpat. Praesent ultrices odio 
in elit fringilla id rutrum mi mattis. Aliquam 
tempus aliquam mauris vel dapibus. 

 

AROUND TOWN 

 

Lorem Ipsum 
Nulla semper orci id leo adipiscing at pulvinar ante 
porta. In quis orci orci, sed pellentesque dui. Aliquam 
nec cursus augue. Sed est massa, ullamcorper vitae 
gravida ut. Curabitur pretium eleifend lectus, at faucibus 
lectus 

 

Dolor Sit Amet 
Nulla semper orci id leo adipiscing at pulvinar ante 
porta. In quis orci orci, sed pellentesque dui. Aliquam 
nec cursus augue. Sed est massa, ullamcorper vitae 
gravida ut. Curabitur pretium eleifend lectus, at faucibus 
lectus 

 

Lorem Ipsum 
Nulla semper orci id leo adipiscing at pulvinar ante 
porta. In quis orci orci, sed pellentesque dui. Aliquam 
nec cursus augue. Sed est massa, ullamcorper vitae 
gravida ut. Curabitur pretium eleifend lectus, at faucibus 
lectus 

  

Title Lorem Ipsum Dolor 
by [Article Author] 
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Lorem ipsum dolor sit amet, consectetur 
adipiscing elit. Nullam sed luctus tellus. 
Pellentesque in dolor sapien, vitae dictum 
massa. Aenean vitae lorem dui. Morbi 
tempus lacinia nisi, vel scelerisque nibh 
facilisis id. Integer urna tortor, ullamcorper 
aliquet viverra non, mollis sed dolor.  

Donec nunc velit, pretium eu pellentesque 
eget, mollis vel arcu. 

Suspendisse vel purus nec erat pellentesque 
commodo. Aliquam tempus aliquam mauris 
vel dapibus. Nullam at metus erat, in 
convallis massa. Aliquam erat volutpat. 
Praesent ultrices odio in elit fringilla id 
rutrum mi mattis. 

Duis purus eros, aliquam eu cursus tincidunt, 
feugiat vitae magna. Etiam sodales 
consequat nibh, eget rhoncus metus 
convallis et. Morbi rutrum mollis facilisis. 
Aenean faucibus  

Morbi tempus lacinia nisi, vel scelerisque 
nibh facilisis id. Integer urna tortor, 
ullamcorper aliquet viverra non, mollis sed 
dolor. Etiam sodales consequat nibh, eget 
rhoncus metus convallis et. 

Phasellus dignissim nulla at diam fermentum 
in sollicitudin sem condimentum. 
Pellentesque condimentum diam et sem 
rhoncus semper sed at libero. Aenean 
condimentum, lorem vel faucibus 
pellentesque, quam nunc lacinia augue, vel 
sagittis dolor ipsum vitae velit. Ut feugiat 
odio ac dolor iaculis consequat. Praesent sed 
lacus ante. Nullam pretium commodo libero, 
at congue sapien dignissim a. Cum sociis 
natoque penatibus et magnis dis parturient 
montes, nascetur ridiculus mus. In hac 
habitasse platea dictumst. Vestibulum ante 
ipsum primis in faucibus orci luctus et ultrices 
posuere cubilia Curae; Ut fermentum sem 
non metus faucibus blandit. Sed placerat 
bibendum fermentum. 
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